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Ngan hang cau hoi Tin hoc
Ml
Cau 1.
Loai may tinh nao sau day co tinh di d<)ngcao nhat?

A. Laptop
B. May tinh d~ ban
c. May tinh chu
D. May tinh bang

Cau 2.
Phuong an nao th~ hien su han ch~ cua di~n thoai thong minh khi su dung chung d~:

A. vi~t ghi chu, soan thao van ban
B. hrot web, xem video
C. d~ lam t~t ca cac cong viec cua mot may tinh
D. choi tro choi, soan email

Cau J,
Dau 1athi~t bi phan cirng cua may tinh?

A. MS PowerPoint 2013
B. Mainboard (Bo mach chu)
C. HDH Windows
D. MS Office

Cau 4.
Khi may bi ngat nguon dien, loai b<)nho nao khong bi m~t thong tin?

A. DRAM
B. RAM
C. Cache
D. ROM

Cfiu 5.
T6c d<)/dQcghi cua thi~t bi nho nao duoi day la nhanh nh~t?

A. USB
B. HDD
C. RAM
D. Cache

Cau 6.
Dan vi nao dung d~ do dung lucng b<)nho may tinh?

A. OB
B. Hz
C. Mbps
D.OHz

Cau 7.
Thi~t bi nho nao sau day co anh huang 16n nh~t d~n t6c d<)xu Iy cua may tinh?

A. HDD



B. ROM
C. ROM BIOS
D. RAM

Cau 8.
1 TeraByte bang bao nhieu GigaByte?

A. 1000
B. 100
C. 1420
D. 1024

Cau 9.
Dau hi dan vi do t6c dQ quay cua 6 dia cung?

A. GB '
B. rpm
C. MB
D. Mbps

Cfiu 10.
Dau 1£1dan vi do t6c dQghi/doc cua phuong ti~n hru tnr?

A. GB
B. rpm
C. Mbps
D. MHz

Cau 11.
Thi~t bi n110sau day vira lit thi~t bi nhap, vira lit thi~t bi xufit?

A. Tai nghe co micro
B. Webeam
C. Chuot
D. May scan

Cfiu 12.
Trong de loai cong diroi day, e6ng nao da dung nhat?

A. Cong mang
B. Cong n6i ti~p
C. Cong song song
D. Cong USB

Cfiu 13.
Trong nhirng phan mern sau day, diu, lit phan m~m irng dung?

A. Windows Phone
B. Linux
C. Windows 10
D. PowerPoint

Cau 14.
Dau lit phan mern h~ thong?

A. Windows 10
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B. Paint
C. Corel
D. Photoshop

Cau 15.
Phan mem nao dung dS tinh toan, thiSt kS bang bieu, tao bieu d6, s~p xSp, phan loai, thong ke,

?

A. Phan mern xu Iy van ban
B. H~quan tri co sa dfr li~u
C. Ph~n m~m trinh chieu
D. Ph~n mern bang tinh

Cau 16.
Qua trinh tao phan mern thea Mo hinh thac mroc co cac giai dean nao?

A. Phan tich; ThiSt kS; Thirc hien; Ki~m thir; Chuyen giao; Bao tri
B. Kiem thir; Thuc hien; Chuyen giao
C. Bao tri; Phan tich.Thiet kS
D. Chuyen giao; Bao tri; KiSm thir; KiSm dinh

Cau 17.
Giai dean "Bao tri" la giai doan nao trong yang dai cua mot h~ thong?

A. D~u tien cua yang dai
B. d gifra yang dai
c. G~n cu6i yang dai
D. CU6i cung cua yang doi

Cau 18.
Cac chuang trinh may tinh co th~ duoc thuc hien nSu da duQ'c n?p vao thiSt bi nha nao?

A. The nha USB
B. Be:>nha ngoai
C. Dia cling
D. BQnhaRAM

Cau 19.
Phuang an nao lien quan d~n khai ni~m m?ng may tinh?

A. La me:>tt~p hQ'pcac may tinh duQ'c kSt n6i vai nhau thong qua duang truy~n v~t Iy va sir
d\mg chung mQt giao thuc m?ng d~ chia se thong tin va tai nguyen I~n nhau.

B. dung d~ so?n thao van ban, t?O bang bi~u, ...
C. May vi tfnh; may in, di dQng, ti vi ... "chung duQ'c bi~t dSn nhu Ia nhfrng may tr?m."
D. KSt n6i duQ'c th\fc hi~n thong qua cac moi truang truy~n thong t6c de:>cao vi d\l cap

d6ng tr\lc hay cap quang hay kSt n6i khong day

Cau 20.
Dau la thu t\1 s~p xSp giam d~n theo ph?m vi m?ng may tinh?

A. M?ng Internet, M?ng LAN, M?ng WAN
B. M?ng Internet, M?ng WAN, M?ng LAN
C. M?ng LAN, M?ng WAN, M?ng Internet
D. M?ng LAN, M?ng Internet, M?ng WAN,
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Cfiu 21.
Phuong an nao noi dSn vai tro ella may chu?

A. Quan ly va eung dp dich vu tai nguyen rnang, phan h6i nlnrng yeu du ducc tao ra til
cac may tram

B. Truy cap dich vu duoc eung dp
C. Nhan hay su dung thong tin diroc cung dp
D. s6 luong ngiroi dung tren mang len dSn hang ngan nguoi

Cau 22.
T6e dQ truyen dfr lieu tren mang duoc do b~ng dan vi nao sau day?

A. MHz
B. Mbps
C. rpm
D. KB

Cau 23.
Phuong an nao lien quan dSn khai niern bang thong (bandwidth)?

A. L~'u IUQ'ngcua tin hieu duoc truyen qua thiSt bi truyen dh trong mot giay
B. Toe dQxu Iy ella bQvi xu Iy
C. DQ dai cua duong truyen
D. Kha nang hru trir thong tin ella thiSt bi di~n nr

Cau 24.
Hay chon phircng an sip xSp thea thir tu tang dAnv~ pham vi cua cac 10l;1imang: Internet,
Intranet va Extranet?

A. Internet, Intranet, Extranet
B. Extranet, Intranet, Internet
C. Intranet, Internet, Extranet
D. Intranet, Extranet, Internet

Csu 25.
Phuong an nao co thu tv sip xSp tang dAncae "dich V\l kSt n6i" thea t6c dQdUCYllgtruy~n?

A. ADSL, FTTH, Dial-up
B. FTTH, ADSL, Dial-up
C. Dial-up, ADSL, FTTH
D. ADSL, Dial-up, FTTH

Cau 26.
Thong tin nao sau day noi v~ ThuO'ng ml;1idi~n tu (e-eommerce)?

A. 1£1vi~c mua va ban cua mQi nguai a sieu thi hay cac chQ'dAum6i.
B. 1£1dieh V\l dung d~ truy v~n thong tin tai khoim va thlJChi~n cac giao dich chuy~n

khoim, thanh toan tn,rc tuySn qua ml;1ngInternet
C. 1£1SlJmua ban san ph~m hay dich V\lva qua trinh giao dich tl,r dQng tren cac M th6ng

di~n tu trlJc tuySn nhu Internet.
D. 1£1vi~c cac cO'quan chinh phu su d\lng mQt each co h~ th6ng CNTT -truy~n thong thl,l'e

hi~n quan M vai cong dan, doanh nghi~p va cae t6 chue xa hQi.
Cau 27.
Khai ni~m nao sau day chi HQi nghi :trl,fCtuySn?
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A. La phuong ti~n cho phep nguoi dung hoc t~p, trao d6i, truy nhap thong tin, tai nguyen
qua moi tnrong mang.

B. Giai phap h6 tro nhi~u nguoi a nhimg dia di~m, vi tri dia Iy khac nhau co th§ cung tham
gia mQt cuoc hQP til' xa; rna a do, ho co th§ nghe, noi, nhin th~y nhau nhu dang a chung
mot phong hQP thong qua phuong tien truyen thong hay internet

C. Nlnrng nguoi lam viec til' nha hoac tren duong clnr khong phai la mot noi lam viec
truyen thong, ...

D. Lit phuong ti~n truyen thong trong tirong lai rna con ngiroi se Slr dung d~ kEt n6i
internet.

Cau 28.
D~ tranh anh huang mat khi Slr dung may tinh lau dai, ta dn phai:

A. Khuyu tay va ban phim nen a mat bang ngang nhau
B. Khoang 10 phut thi dung day hoat dong choc lat d§ thu gian cac b~p thit
C. Hai chan d~ can bang tren san nha
D. Nghi ngoi m~t mQt each thich dang

Cau 29.
D~ tranh b~nh xuO'ng khap khi Slr d\mg may tinh, nguai Slr d\mg nen lUlly:

A. Khoang 10 phut thi dung d~y ho~t dQng eh6c lat dS thu gian eac b~p thit
B. U6ng nuae di~u dQ
C. An u6ng vua dli dS dam bao cO'thS thoai mai
D. Cho m~t nghi ngO'i, t~p th~ dl,lcd~u d~n truac khi Slr dl,mgmay Hnh

Cau 30.
D~ tn1nh nhung b~nh v~ m~t khi dung may tinh lau dai ta nen lUlly:

A. f)i~u ehinh khoang each man hinh va m~t each xa 1m tra len
B. f)i~u ehinh ql ly man hlnh vai m~t t6i thi~u 60cm
C. DS den di~n hay anh sang m~t trai phan x~ tren man hlnh
D. Cho man hinh nghi ngO'i

Cau 31.
DS dam bao an toim eho ban than khi lam vi~e vai may tinh, nguai Slr dl,lngdn phai:

A. Ng6i phai nang khu)ru tay len eao han m~t ban phim
B. Ng6i dung tu th~, ehQn ki~u va kich thuac ban ghE, s~p x~p thi~t bi phu hgp vai ban

than
C. Ng6i gac chan len eao
D. ChQn ki~u va kich thuac ban ghE d~p

Cau 32.
Ch~t thai tu nhfrng chi~c may tinh ell co anh huang d€n v~n d~ gl?

A. Sue khoe con nguai
B. Bi€n d6i khi h~u
C. Moi truang s6ng xung quanh
D. Moi truang va sue khoe con nguai

Cau 33.
Nguai dung dn phai lam gi dS Slr dl,lngva bao v~ m~t kh~u an toan'?

A. Chia se m~t kh~u cho b~n be va nguai than
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B. Gi~u m~t kh~u ky vao ngan keo
C. Ghi nho m~t kh~u vao s6 tay
D. Chon mat khan co d<)dai thich hop, xen l~n gnra chir cai va s6.

Call 34. Call 8
Lira chon nao sau day lien quan d~n khai niem v~ Spyware may tinh?

A. la I01;1iphfm m~m chuyen thu th~p cac thong tin cua cac t6 chirc hoac ca nhan nr cac
may tinh bi lay nhi€m qua mang Internet rna khong co su nhan bi~t va cho phep cua chu
may

B. Sao hru dfr lieu du phong vao bQriho ngoai
C. Cloud Backup (cong nghe sao hru dam may) giup nguoi sir dung sao hru dfr li~u cua

minh va hru trfr true tuyen
D. Sao luu du phong dfr li~u true tuyen

Call 35. Call 9
Trong cac khai niern sau day, khai niern nao la dung nh~t d6i vai virus may tinh?

A. Virus may tinh la mQt chuang trinh ph~n m~m khong co khil nang tv sao chep chinh no
tir d6i tuqng Hiynhiem nay sang, d6i tuqng kMc.

B. Virus may tinh la mQt chuang tr~nhph~n m€m co khil nang tv sao chep chinh no tren
mQt d6i tuqng nhung khong co kM nang lay nhi~m sang d6i tuqng kMc.

C. Virus may tinh hi mQt chuang triinhph~n m€m co kha nang tv sao chep chinh no tir d6i
tuqng lay nhi~m nay sang d6i tll'<;mgkMc

D. Virus may tinh la mQt chuang Uinh ph~n m€m co kha nang tv dQng ciii d~t tren may
tinh va t6n t1;1ia do vinh vien.

Can 36.
Nguai su d\mg nen lUll y nQi dung naq sau day d~ d€ phong may dnh bi nhiem virus?

A. Tranh nguai 11;1m~t
B. Khong rna cac thu 11;1,khong rOInoi dung
C. Khong cclicac chuang trinh m(h
D. V~ sinh, lau chui may tinh S1;1chse d€ tranh gay nhi~m virus

Call 37.
Hanh d<)ngnao co th€ d~n d~n cac ph~n m€m doc h1;1it~n cong gay nguy hi€m cho may tinh
cua b?n?

A. T~t ch~ do autorun cho USB
B. V~n chuy~n may tinh tir nai nay sang nai khac
C. Click VaGduang link quilng c~o, mai gQi, khong ro
D. Khong click vao hinh anh quang cao nh?y cam

Can 38.
PMt bi~u nao sau day la dung vai ph~n m€m ma ngu6n rna?

A. Nguai slr d\mg duqc cung dp rna ngu6n va mien phi ban quy€n nhung khong duqc sua
d6i, nang dp hay cciiti~n.

B. Nguai su d\mg chi duqc cung dp ma ngu6n d~ su d\mg va nghien CUu nhung khong
duqc sua d6i, nang dp hay cai ti~n.

C. Nguai su d\mg duqc cung dp rna ngu6n va mi€n phi ban quy€n, duqc tuy y sua d6i, di
ti~n, nang dp, pMt tri~n va qan l?i cho nguai dung kMc.
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D. Nguoi sir dung duoc cung dp ma nguon va mi~n phi ban quyen cling nhu duoc sira d6i,
cai tien, nang cap, phat trien thea mot s6 nguyen t~c chung ghi trong gi~y phep rna
nguon GPL.

Cau 39.
PhM bieu nao sau day la dung d6i voi giiy phep ph~n mern (Software License)?

A. La mot tai li~u cung dp cac huang dan vS phuong phap I~p trinh va slr dung phan mern.
B. La met tai lieu cung dp cac huang dan vS vi~c cai d~t va sir dung phan mem.
e. La mot tai lieu cung dp cac huang dan vS rang buoc phap Iy cho viec sir dung hay phan

phoi phan mSm
D. La m(1t tai li~u cung cap cac huang dan cho giao vien d~ nghien cuu va truyen thu each

tlnrc sir dung phan mern,
Cau 40.
Phftn mem co ban quyen duoc xac dinh thong qua ySu t6 nao?

A. Giiy phep phftn m~m va huang dan su d\lng.
B. Gi~y phep phftn mSm va rna dinh danh san ph~m phftn m~m.
e. Gi~y phep phfrn mSm va tac gi,L
D. Gi~y phep phftn mSm va rna ngu6n.

Call 41.
Theo Lu~t Sa huu tri tu~ 2005, d6i tugng mio sau day KHONG la Chll sa hfru quy~n tac gia?

A. la t6 chuc, cci nhan giao nhi~m v\l cho tac gia ho~c giao kSt hgp d6ng vai tac gia
B. la nguai thil"akS
e. la nguai dugc chuy~n giao quy~n
D. la nguai su d\lng san ph~m clla tac gia

Call 42.
Theo DiSu 22 clla Lu~t Sa hfru tri tu~ 2005, ban quySn phfrn mSm dugc xac dinh nhu thS nao?

A. La quySn clla tac gia d6i vai chuang trinh may tinh, suu t~p du' li~u
B. La quySn tac gia d6i vai nguai sir d\lng
e. La quy~n tac gia d6i vai du li~u may tinh
D. La quySn tac gia d6i vai chuang trinh may tinh

Call 43.
Lva Ch9n nao sau day la khai ni~m dfry dll vS "bao v~ dfr 1i~u"?

A. Bao v~ du li~u la quy tri11hluu giu nhung thong tin quan tr9ng.
B. Bao v~ du li~u la quy trinh dam bao nhung thong tin quan tl"{;mgdugc lUll tru.
e. Bao v~ du li~u 1aquy trinh sir d\lng cac h~ th6ng iClouds d~ lUll tru nhung thong tin

quan tr9ng.
D. Bao v~ dfr li~u la quy trinh dam bao s\r an toan cho nhung thong tin quan tr9ng khong bi

hu h<;1i,sai l~ch, 1(1ra ngoai ho~c m~t mat.
Call 44.
DiSu 72, Lu~t Cong ngM thong tin nam 2006 vS "Bao dam an tOflll,bi m~t thong tin", t6 chuc,
ca nhan KHONG dugc lam gi?

A. Bao dam bi m~t thea quy dinh clla phap lu~t nhung thong tin hQ'pphap cua t6 chuc, ea
nhan luu trfr tren moi tmang m<;1ng.
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B. Duoc sir dung m~t khau, khoa m~t rna d@bao v~ thong tin cua minh tren moi twang
mang

C. Ngan chan viec truy nhap d~n thong tin ella t6 clnrc, ca nhan khac tren moi tnrong
mang, n~u phap lu~t eho phep

D. Xarn nhap, sua d6i, xoa bo noi dung thong tin ella t6 chirc, ca nhan khac tren moi
tnrong mang

M2. SU' dl:ln9 may tinh
Call 45.
Trinh W thong thuong cac cong viec dl'l thuc hien khi Slr dung may tinh la:

A. Mo' may va dang nh~p --> chuan bi mdi tnrong lam viec --> quan ly dfr lieu --> chay
cac phan mem ung dung --> luu 'k~t qua --> k~t thuc lam viec --> t~t may.

B. Chuan bi moi tnrong lam viec --> quan Iy dfr lieu --> mo may va dang nhap --> chay
cac phan mem ung d\lng --> luu.k~t qua --> k~t thue lam vi~e --> t~t may.

C. Ma may va dang nMp --> ehu~n bi moi tmang lam vi~c --> lUllk~t qua --> k~t thuc lam
vi~c --> t~t may --> quan Iy dfr lii~u,ch~y cae phfrn m~m ung d\lng.

D. Ma may va dang nh~p --> ch~y :cac phfin m~m ung d\lng --> chu~n bi moi tmang lam
vi~c --> quan ly dfr li~u --> lUllk~t qua --> k~t thuc lam vi~e --> t~t may.

Call 46.
D~ t~t mQt ung d\lng bi treo v6i Task ¥anager, ta nh~n t6 hQ'pphim :

A. Ctr! + Alt + Del
B. Ctr! + Shift + Del
C. Shift + Alt + Del
D. Ctr! + Home + Del

Call 47.
Trong Windows 7, d~ t~t cfra s6 hi~n manh, ta th\1c hi~n nhu sau:

A. Vao Start --> ChQn Log off.
B. Nh~n t6 hQ'pphim Ctr!+4.
C. Vao Start --> ChQn All Program --> Shut down.
D. Nh~n t6 hQ'pphim Alt+F4.

Call 48.
Khi sfr dl,lllgh~ di~u hanh Windows 7, d~ khai dQng l~i may tinh, ta lam nhu sau:

A. Vao Start --> Log off
B. Vilo Start --> Restart
C. Vao Start --> Hibernate
D. Vao Start --> Sleep

Call 49.
Khi Slr d\lng h~ di~u Mnh Windows,!d~ bao an toan ta dang nh~p vao may tinh thong qua:

A. Administrator
B. Username va password
C. Username
D. Password

Call 50.
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Trong Windows, ch~ dQ t~tmay nao hru trang thai lam viec truce khi t~t may?
A. Hibernate
B. Standby (Sleep)
C. Shutdown (Turn off)
D. Restart

Cau 51.
Khi lam viec voi Windows, chirc nang cua phim FIla:

A. Mer ch~ dQtoan man hinh
B. D6i ten file hay thu muc
C. Mer cira s6 tro giup
D. HiSn thi thanh Menu tren cac cira s6 dang dung

Cau 52.
Phat bieu nao sau day vS thanh nhiem vu (taskbar) la dung nhk

A. Cung dp cac cong cu (lenh) giup cho nguci su dung thao tac vdi cong viec mQt each d~
dang han

B. La noi ban co th~ d~t len do moi tlnr nhu cac t~p tin, thu muc va s~p xSp chung
C. La cac hinh anh dai dien cua cac chuang trinh duoc cai d~t trong may tinh, khi nhay

chuot vao cac icon nay se giup ngiroi su dung truy c~p mQt each nhanh chong
D. Chua cac bieu tuong cua cac chuang trinh dang chay hi~n thai, thuang co vi trf erphia

duai mim hinh Desktop
Cau 53.
Khi lam vi~c vai Windows, d~ d~t mQt anh lam hinh n~n, sau khi nh~p chuQt phai vao bi~u
tUQ'ngcua anh mu6n su dl,lng, ta chQn:

A. Preview
B. Send to --> Desktop
C. Open with --> Windows Photo Viewer
D. Set as Desktop Background.

Cau 54.
Trong Windows 7, (tS gO' b6 mQtph~n mSm ung dl,lng, sau khi vao Start --> Control Panel -->
Programs, ta Ch9n:

A. Uninstall a program
B. View intalled updates
C. How to install a program
D. Turn Windows features on or off

Cau 55.
DS su dl,lngchuc nang trQ'gillp co s~n cua Windows ta su dl,lng:

A. T6 hQ'pphfm Windows+Fl
B. PhimFII
C. Phim Windows
D. T6 hQ'pphim Alt+FI

Cau 56.
BiSu tuQ'ng la:

A. MQt nai co thS su dl,lngdS luu trfr cac t~p tin trong do
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B. MQt anh nho, co sire bieu cam vS d6i tuong (file, thu muc, chuang trlnh hoac mo: d6i
nrong, chirc nang khac)

C. MQt lien k~t d~n mot muc (chang han nhu mot t~p tin, tlur muc, hoac chuang trinh) tren
may tinh cua ban

D. MQt rnuc chua thong tin, vi du, van ban hoac hinh anh hay am thanh
Call 57.
Chirc nang cua thanh tieu dS la:

A. HiSn thi ten cua tai li~u va chuang trinh rna ban dang lam viec
B. Dung dS hru ten cua tai li~u va chuong trinh rna ban dang lam viec

, I "' ,

C. Cho phep ban di chuyen cac nQi dung cua cira so de xem thong tin khi chung a ngoai
t&mnhin

D. Chua cac rnuc cho phep ban nh~p chuot vao d~ thuc hien mot chon hra
Call 58.
D~ di chuyen til' cira s6 nay sang cira s6lkhae, ta nh~n t6 hop phim:

A. Ctrl+PgUp ,
B. Ctrl+A
C. Alt+PgDn
D. Alt+Tab

Call 59. ,
Voi mot cira s6 dang rna toan man hin~, d~ phl,le h6i kieh thuac truac do cua eua s6, ta click
len nut l~nh:

A. Close
B. Maximize
C. Restore
D. Minimize

Call 60.
PMt biSu nao sau day vS t~p (file) la 4ung nh~t:

A. La nai luu trfr cae thu ml,lCcung mQt chu dS nao do theo y eua nguai su dl,lng nh~m ml,lC
dich truy xu~t d~ dang, ti~n 19~

B. La nai lUll tru cae hinh anh c6:trong may tinh. Cae hinh anh nay duge lUll vai thu~t toan
nen lossy

C. La t~p hgp cac thong tin co li~n quan vai nhau duge lUll trfr tren bQnha ngoai, do chinh
la cae chuang trinh, dfr li~u dlilgc lUll tru tren ilia

D. La mQt hinh 8.nhnh6, co sue bi~u cam vS d6i tugng (thu ml,lC,chuang trinh ho~e mQt
d6i tugng, mQt chuc nang nao do)

Call 61.
"jpg" la ph~n rna rQng cua 101;lit~p tip:

A. Van ban
B. Bang tinh
C. Am thanh
D. Hinh anh

Call 62.
Thu ml,lCg6c la thu ml,lc:
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A. Cao nh~t tren dia, dUQ"Ct<;10ra trong qua trinh dinh dang va khong bi xoa bo.
B. Cha cua t~t cac thtr muc trong may tinh. Cac thu muc khac la thu rnuc con ella thir muc

nay.
C. Khong chua thir muc con, chi chua cac t~p tin thi hanh co phan rna rong la "exe".
D. Hien hanh, dang lam viec.

Cfiu 63.
Thir muc la:

A. noi chua t~t ca cac t~p tin (van ban, hinh anh, am thanh, ..) co trong may tinh va dUQ"C
s~p xSp thir tv tang d~n theo ten.

B. noi chi hru tnr cac file chuang trinh irng dung duoc dung d~ cai d~t cho may tinh.
C. mot bi~u tuong tren man hinh giup nguoi dung truy c~p nhanh vao d6i nrong thuong

hay sir dung bang each nhap dup chuot vao do.
D. mot dang t6 clurc cua 6 dia co cong dung nhir la mQt ngan chua, ducc dung trong viec

quan Iy va s~p x~p cac t~p tin.

Cau 64.
Vi~c sao lUll t~p thuang xuyen tai mQt thi~t bi lUll trfr di dQng nh~m:

A. Ti~t ki~m bQ nha
B. Tranh m~t mat dfr li~u
C. Chia se dfr li~u
D. Bao m~t dfr li9u

Cau 65.
HDD la tir vi~t t~t ti~ng Anh clla:

A. 6 dla m~m
B. 6 dia USB
C. 0 dia quang
D. 6 dia cung

Cau 66.
Trong Windows Explorer, d~ s~p xSp t~p tin va thu m\lc thea tr~t tv ten khi hi~n thi ta lam nhu
sau:

A. Nh~p chuQt trai len vUng tr6ng Cllacua s6 hi~n thi --> View -> Type
B. Nh~p chuQt phai len vtmg tr6ng Cllaeua s6 hi611thi --> View --> Name
C. Nhftp ehuQt phai len vung tr6ng ella cua s6 hi611thi --> Sort by --> Type
D. Nhftp chuQt ph iii len vUng tr6ng Cllacua s6 hi~n thi --> Sort by --> Name

Cau 67.
Trong Windows Explorer, d~ s~p x~p t~p tin va thu m\lc thea tr?t W kich thuac khi hi6n thi ta
nh~p chuQt phiti len vimg tr6ng Cllacua s6 hi~n thi va cl1Qn:

A. Sort by --> Size
B. Sort by --> Byte
C. View --> Length
D. View --> \Vidth

Cau 68.
Trong Windows Explorer, d~ t<;10thu m\lC, sau khi vao File-->New ta ch<;m:

A. Shortcut

II



B. Folder
C. Bitmap Image
D. Text Document

Cau 69.
Trong Windows Explorer, d~ tao mot thu muc con cua mot thu rnuc ta chon:

A. Thu muc g6c co chua thir muc do.lam thir muc hien hanh
B. Thir muc cha cua thu muc do lam thu rnuc hien hanh.
C. Thu muc do lam tim muc hien hanh
D. Thu muc con cua thir muc do lam thir muc hien hanh

Cau 70.
Trong Windows Explorer, d~ d6i ten tep va thir muc ta lam nhu sau:

A. Nh~p dup chuot vao t~p tin hoac.thu rnuc do --> go lai ten --> nhan Enter
B. Nh~p chuot phai vao t~p tin hoae thir muc do --> go lai ten --> nh~n Enter
C. Nh~p I I~n van t~p tin hoac thir muc do --> go lai ten --> nh~n Enter
D. Nh~p chuot phai van t~p tin hoac thu muc do --> Chon Rename --> go lai ten va nh~n

Enter
Cau 71.
Trong Windows, phan ten eua t~p tin bilo g6m:

A. Cae ky t\1'tiI A d~n Z, 0 d~n 9, #,$, %, ~, ", @, (, ) !, _, khoimg tr~ng
B. Cac ky W tiI A d~n Z , #,$, %, __;"", @, (, ) !, _ va d~u /
C. Cac ky t\l' tiI A d~n Z, 0 d~n 9, J,\,:, *, >, <, ?, ", I, khoang tr~ng
D. Cae ky W tiI A d~n Z, 0 d~n 9, khoang tr~ng, d~u "

Cau 72.
Trong Windows Explorer, d~ chQn cae; t¢p ho~c thu m\lC rai r:;lCnhau tren 0 hi~n thi thong tin,
ta th\1'chi~n nhu sau:

A. Nhftn gifr phfm Shift va click len cac d6i tUQ'ngdn ehQn
B. Nhftn gifr phfm Alt va click len dc d6i tUQ'ngdn ehQn
C. Nhftn gifr phfm Ctrl va click len cac d6i tUQ'ngdn chQn
D. Nhftn t6 hQ'pphim Ctrl+A

Cau 73.
Trong Windows Explorer, d~ chQn cae t¢p ho~c thu m\lc lien ti~p nhau tren 0 hi~n thi thong tin,
ta th\1'chi~n nhu sau:

A. Nhftp ehuQt tdi len t~p ho~e thu m\lc d~u danh sach ehQn, sau do gifr phim Shift va
click len t~p ho~c thu m\lc cu6i danh sach chQn.

B. Nhftp chuQt trai len t¢p ho~c thu m\lCdftu danh sach chQn, sau do gifr phfm Ctrl va click
len t~p ho~c thu m\lc cu6i danh sach chQn.

C. Nhftn t6 hQ'pphfm Ctrl+A.
D. Nhftp chuQt trai len t¢p ho~c thu m\lCd~u danh sach chQn, sau do gifr phfm Alt va click

len t~p ho~c thu m\lc cu6i danh sach chQn.
Cau 74.
Trong Windows Explorer, d~ sao chep t¢p tll thu m\lc nay sang thu m\lC kMc, sau khi chQn t¢p
dn sao chep ta th\1'chi¢n nhu sau:

A. ChQn Cut --> Tim d~n thu m\lC dn sao chep tai --> ChQn Paste
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B. ChQI1Open --> Tim d~n thir muc dn sao chep tci --> Chon Paste
C. Chon Save As --> Tim d~n thu muc dn sao chep toi --> Chon Paste
D. Chon Copy --> Tim dSn thir muc dn sao chep toi --> Chon Paste

Call 75.
Trong Windows Explorer, t6 hop phim Ctrl+C va Ctrl+V diroc dung d~:

A. Xoa t~p tin, thu muc
B. Di chuyen t~p tin, thu muc
e. Nen t~p tin, thu muc
D. Sao chep t~p tin, thir muc

Call 76.
Trong Windows Explorer, t6 hop phim Ctrl+X va Ctrl+V dung d~:

A. D6i ten tap tin hay thu muc
B. Sao chep t~p tin hay thir muc
e. Di chuyen t~p tin hay tim rnuc
D. Nen t~p tin hay tim muc

Call 77.
Trong Windows Explorer, thao tac chon t~p tin hoac thir muc, sau do nh~n phim Delete co kSt
qua gi?

A. Xoa vinh vi~n t~p tin hoac thu muc khoi may tinh
B. Xoa vinh vi~n t~p tin hoac thu muc khoi bQ nho.
e. Xoa tarn thai t~p tin hoac thir muc khoi bQ nha may tinh.
D. Xoa t~m thai t~p tin ho~c thu m\lc (dua VaGthung rae).

Call 78.
Trong Windows 7, d~ kh6i ph\lC 111Qtt~p tin tir thung rac, sau khi 1110' Recycle Bin, ta thl,l'chi~n
nhu sau:

A. ChQn t~p tin dn kh6i ph\lc --> Restore this item
B. Nh~p chuQt phai VaGt~p tin trong thung rac dn kh6i ph\lc --> Copy
e. Nh~p chuQt phai VaGcae t~p tin trong thimg rae --> Paste
D. Nhftp chuQt phai VaGcac t~p tin trong thimg rac --> Restore all

Call 79.
Trong Windows Explorer, d~ dQn s~ch thung rac, sau khi mO'Recycle Bin, ta thvc hi~n:

A. ChQn Restore all items
B. Nhftp chuQt phai V~lOmQt t~p tin hay thu ml,lc --> ChQn Cut
e. ChQn Empty Recycle Bin
D. Nhftp chuQt phai VilOmQt t~p tin hay thu m\lc --> ChQn Delete

Call 80.
Vi~c nen t~p tin nh~m m\lc dich:

A. Kh6ng cho virus t~n e6ng lam hu hong dfr li~u duQ'c luu tru.
B. Kh6ng cho nguai khac thlJc hi~n vi~e chinh sua t~p tin.
e. DQn d~p bQ nha, lam eho may tinh ho~t dQng duQ'cnhanh va 6n djnh han.
D. Thu gQn kich thuac de t~p tin giup lUll trfr, truy~n du li~u duqc d~ dang.

Call 81.
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Ch~ dQ bao v~ thai gian thuc cua phan m€m Windows Defender se:
A. TV dong loai bo bftt ctr cac phat hien trong qua trinh quet
B. Quet phan mern gian di~p co th~ duoc cai d?t tren may tinh cua ban
C. Canh bao khi co mQt chuang trinh c6 g~ng d~ thay d6i cac thiet l~p quan trong trong

Windows
D. Cho phep len lich quet mQt each thuong xuyen.

Cau 82.
Cac loai djnh dang t~p am thanh bao g6m:

A. MP4, MP3 va WMA.
B. MP3, WAV va WMA.
C. Dinh dang khong nen, nen khong mftt dtr lieu (lossless) va dinh dang dS mat dfr lieu.
D. Dinh dang nen va dinh dang khoag nen.

Cau 83.
Cum til' nao sau day la ten cua font chit;

A. Times New Roman
B. Vietware X
C. Unicode
D. TCVN3

Cau 84.
Giai phap h6 tro Ti~ng Vi~t cai s~n ben trong mQt s6 h~ diSu himh la:

A. Ph~n mSm go ti~ng Vi~t Unikey
B. Ph~n mSm GoTiengViet '
C. Ban phfm Ti~ng Vi~t
D. Ph~n mSm go ti~ng Vi~t Vietkey

Cau 85.
Trong khung diSu khi~n Clla ph~n mSm Unikey ta co th~ chQn:

A. Ki~u go va font style .
B. Bing ma va ki~u go
C. Font chfr va ki~u go
D. Bing mil va font chu

Cau 86.
Voi cac font chfr khac nhau tren cling mQt bing ma trong mQt van bin, d~ th6ng nhftt mQt font
chu thi:

A. Chi dn thao tac chQn Il;licling font chu
B. Nhftt thi~t cfrn phai co ph~n mSm chuyen d\lng
C. Khong thvc hi~n duQ'c
D. Chi dn thao tac chQn ll;licling kich cO' (font size)

Cau 87.
D~ thay d6i may in m?c dinh til'mQt,danh sach may in di s~n, sau khi VilO Control Panel-->
Devices and Printers, ta hIm nhu sau:

A. Nhftp chuQt phai len may in Gfrnm?c dinh --> Set as Default Printer
B. Nhftp chuQt phai len may in cfrnm?c dinh --> See What's printing
C. ChQn Add a printer
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D. Nhap chuot phai len may in dn mac dinh --> Printer Properties

Cau 88.
f)~ cai d~t m<)tmay in moi dil diroc kSt n6i tnrc tiSp vao may tinh, sau khi vao Start -->
Devices and Printers, ta chon:

A. Add a printer --> Add a network, wireless or Bluetooth printer
B. Add a printer --> Add a local printer
e. File --> Add a Device
D. Add a device

M3. soan thao van ban
Cau 89.
Trinh bay van ban bao g6m:

A. Soan thao nQi dung, bien t~p van ban, hru gill' van ban, in ~n va phan ph6i van ban
B. Nhirng thanh phan chung ap dung d6i voi cac loai van ban va cac thanh phan b<3sung

trong nhirng tnrong hop cu th~ hoac d6i voi mot s6 loai van ban nhat dinh
e. Kh<3gi~y, kieu trinh bay, dinh I~trang van ban, vi tri trinh bay cac thanh phftn the thuc,

phong chir, cO'chtr, ki~u chir va cac chi ti~t trinh bay khac.
D. Dinh dang van ban va dinh dang dean van

Cau 90.
£)~ co duoc mQt van ban thea yeu du, sau khi soan thao n<)idung ta dn thuc hi~n cac thao tac
sau:

A. Thay d6i dinh d<;ing,them minh hQa, t<;iOcac lien k~t, tham chi~u, hoan chinh van ban, in
~n va phan ph6i van ban.

B. Bien t~p van ban, luu gift van bim, in fin va phan ph6i van ban.
e. Them bat, sua chll'a nQi dung, thay d6i dinh d~ng, them minh hQa, in ~n va phan ph6i

van ban.
D. Them bat, sua chua n<)idung, thay d6i dinh d~ng, them minh hQa, t~o d.c lien kSt, tham

chiSu, hoan chinh van ban, luu gifr van ban, in ~n van ban.
Cau 91.
Trinh t\1'nao la hqp Iinhfit khi SO<;inthao m9t van ban?

A. Chinh sua --> trinh bay --> go van ban --> in fin
B. Go van ban --> trinh bay --> chinh sua _..> in ~n
e. Go van ban --> trinh bay --> in fin --> chinh sua
D. Go van ban --> chinh sua --> trinh bay --> in ~n

Cau 92.
Phftn m~m nao sau day la phftn m~m xu ly van ban?

A. OpenOffice Impress
B. LibreOffice Calc
e. CutePDF Writer
D. OpenOffice Writer

Cau 93.
Chuc nang chinh cua m9t phftn m~m xU'ly van ban la gi?

A. T<3chuc va dinh d~ng van bim
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B. Soan thao va xu Iy van ban
c. Bien t~p van ban
D. Soan thao van ban

Cau 94.
Trinh bay van ban la viec thuc hien:

A. Tao chtr nghe thuat
B. Sua d6i du true van ban
C. Dinh dang ky tu, dinh dang doan ~an ban, dinh dang trang van ban
D. Chen tranh, anh vao van ban

Cau 95.
Trong MS Word, each nao sau day dung!d~ rna mot van ban co s~n tren dia?

A. Ctrl + N
B. Ctrl + F
C. Ctrl + 0
D. Ctrl + A

Cau 96.
" I

Be chen mot so ky tu, ky hieu d~e bi~t nhu ©, ®, ™, cac ehfr cai Hy Lap vao van ban ta vao
I

tab Insert sau do chon lenh nao? I

A. Symbol
B. Equation
C. Signature Line
D. SmartArt

Cfiu 97.
Cac diu huyen, s~e, hoi, nga, nang theo kieu Telex l~n IUQ't nrong ling voi nhfrng ky nr nao?

A. f, s, r, x, j ,
B. s, f, r,j, x
C. f, s, j, r, x
D. s, f, x, r, j

Cau 98.
Khi SIT dung MS Word, ta nhan t6 hop phim nao sau day d~ hru tai li~u hien hanh?

A. Alt+S
B. Ctrl+Shift+S
C. Shift+S
D. Ctrl+S

Cau 99.
SUdung lenh Save As trong tab File thay eho lenh Save khi muon:

A. Chi dinh Word luon luon tao ban sao du phong
B. Luu m(>tali li~u du6i mQt ten khae ho~e vi tri khae
C. Gui tid li~u qua thu di~n tu
D. Luu van ban tren m~ng

Cau 100.
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Trang MS Word 2010, khi hru van ban, muon ten cua t~p tin co phan rna rong .DOC thi ta
chon ki~u t~p tin nao trong phftn Save as type?

A. Word Document
B. Word 97-2003 Template
C. Word 97-2003 Document
D. Word Template

Cau 101.
Khi soan thao trong MS Word, t6 hop phim nao sau day cho phep thuc hien chon toan bQta:
li~u?

A. Alt+A
B. Shift+Ctrl+A
C. Alt+F8
D. Ctrl+A

Cau 102.
Khi S11 dung MS Word, thao tac gift phim Ctrl va nh~p chuot vao mQt vi tri nao do trong dean
van ban se co tac dung gi?

A. Chon mQt cau tai vi tri con tro
B. Chon mQt til
C. Chon toan bQvan ban
D. Chon doan van ban do

Cau 103.
Phim nao d~ xoa mQt ky tv dung tnroc con tro soan thao van ban?

A. Ctr1+Backspace
B. Ctrl+Delete
C. Backspace
D. Delete

Cau 104.
Thao tac Home --> Find dung d~ lam gi?

A. Ki~m tra chinh ta
B. Sir dung d~ go t~t
C. Tim kiem mQt file van ban
D. Tim kiern mQt til hoac mot cum til trong van ban

Cau 105.
T6 hop phim nao sau day dung d~ di chuyen mQt doan van ban da chon til tai li~u nay sang tai
lieu dang rna khac?

A. Ctrl+B, Ctrl+P
B. Ctrl+V, Ctr!+X
C. Ctrl+X, Ctrl+V
D. Ctrl+C, Ctrl+V

Csu 106.
Trong MS Word, d~ huy k~t qua vira lam (undo) ta S11 dung phim nao sau day?

A. Ctrl+Backspace
B. Ctrl+Z
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C. Ctr1+Y
D. F4

Cfiu 107.
Trong MS Word, sau khi hra chon phan van ban, nh~n t6 hop phim Ctrl + B va Ctrl + I, phan
van ban do se thay d6i nhir th~ nao?

A. Duoc in darn
B. Duoc in nghieng
C. Duoc in dam va in nghieng
D. Duoc in d~m va gach chan

Cau 108.
Trong MS Word, su dung t6 hop phim nao sau day d~ b?tlt~t ch~ dQchi s6 duoi?

A. Shift + =
B. Ctrl + =
C. Alt + =
D. Ait + Shift + =

Cau 109.
Trong MS Word, su dung t6 hop phim nao sau day d~ b?t/t~t ch~ dQchi s6 tren?

A. Ctrl + =
B. Shift + =
C. Ctrl + Shift + +
D. Alt + Shift + =

Cau 110.
Trong MS Word, muon chuyen toan bQ cac ky tu trong kh6i van ban ducc chon til chir hoa
sang chir thucng va ngiroc lai, sau khi.chon kh6i van ban ta dung t6 hop phim nao sau day?

A. Ctrl + Shift + F3
B. Shift + F3
C. Alt + F3
D. Ctri + F3

Cau 111.
Trong MS Word, muon chon mdt doan van ban ta linn nhu th~ nao?

A. Nhfrn Ctrl va Click VaG vi tri b~t ki trong doan.
B. Nhfrn Ctrl+A
C. Nhap doi chuot VaG khoang tr6ng ben trai cua mQt dong trong doan,
D. Nhftp chuQt 3 lfin VaG khofmg ,tr6ng ben tnii cua mQt dong trong do~n.

,

Cau 112.
D~ ng~t do~n van ban trong MS Word, ta ph~lid~t con tro so~n thao t~i vi tri dn ng~t, sau do
th\1'chi~n cong vi~c nilOsau day?

A. Vao tab INSERT -> Page Br~ak
B. Vao tab Page Layout -> Brea:k
C. Nhfrn Shift+Enter
D. Nhfrn Enter

Cau 113.
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Trong MS Word, khi muon ng~t dong nhung khong ng~t doan ta d~t con tro soan thao ngay
phia truce tir muon ng~t xuong dong sau do nhftn phim gi?

A. Enter
B. Spacebar
C. Ctrl + Enter
D. Shift + Enter

Cfiu 114.
Trong MS Word, dS din thang I~ trai cho mot doan van han da diroc chon, ta str dung t6 hop
phim nao?

A. Ctrl + C
B. Ctrl + R
C. Ctrl + L
D. Ctrl + J

Cau 115.
Phat bieu nao sau day la dung nhftt v~ cong dung cua viec sir dung chuc nang nhay each (tab)?

A. Khi nhftn phim Tab, con tro soan thao se diroc tv dong chuyen d~n vi tri diSm dung g~n
nhftt

B. Khi nhftn phim Tab, con tro soan thao se duoc tv dQng chuyen d~n vi tri diSm dung ben
trai g~n nhftt

C. Khi go van ban tai vi tri diSm dung, van ban se duoc can l~ tai vi tri do thea kieu tab da
chon.

D. Khi go van ban tai vi tri diSm dung, van ban se duoc can l~ giua tai vi tri hien thoi.

Cfiu 116.
Trong MS Word, dS dan khoang each gifra cac dong la 1,5 line, ta chQn eae dong dn dan sau
do nhftn phim nao sau day?

A. Ctrl+l,5
B. Alt + 1,5
C. Ctr + 5
D. Alt + 5

Cau 117.
Trong MS Word, eang d\mg CllaStyle la gl?

A. Dung dS dinh d<;lngfont chii' cho mQt kh6i van ban
B. Lil cang C\lsao chep dinh d~ng
C. Dung dS dinh d~ng mQt kh6i van ban thea mau
D. Dung dS t~o m\lC l\lc W dQng mQt dch nhanh chong

Cau 118.
Trong MS Word, mU6n them mQt bang VaGvan ban, d~u tien ta th\fc hi~n thao tac:

A. Insert --> Text Box
B. Insert --> Table
C. Insert --> Picture
D. Insert --> Shapes

Cau 119.
Trong MS Word, dS chQn mQt a trong bang, ta lam nhu th~ nao?
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A. Chon toan bQ van ban dang co trong a do
B. Dua chuot d~n bien phai cua a do, xuit hien miii ten mau den, kich chuot trai
C. Dira chuot d~n bien trai cua a do, xuit hien miii ten mau den, kich chua! trai
D. Dua chuot d~n bien trai cua a do, xuit hien mili ten mau den, kich chu6t phai

Cau 120.
Trong MS Word 2010, d~ chon cQtchtra.o dang d~t con tro soan thao ta vao tab Table
Tools/Layout --> Select, sau do chon:

A. Select Table
B. Select Row
C. Select Column
D. Select Cell

Cau 121.
Trong MS Word 2010, muon xoa mo; dong trong bang, ta d~t con tro soan thao tai bit ky a nao
tren dong do, sau do vao tab Table Tools/Layout -> Delete chon:

A. Delete Columns
B. Delete Cells ...
C. Delete Table
D. Delete Rows

Cau 122.
Trong MS Word 2010, d~ thay d6i duqng vi~n cho a dang dircc chon, ta thuc hien:

A. Page Layout --> Page Borders
B. Page Layout --> Margins ,
C. Table Tools\Design --> Borders
D. Table Tools\Layout --> View Gridlines

Cau 123.
Trong MS Word 2010, d~ xoa toan bQbang khoi van ban each nao sau day la dung?

A. Chon toan bQbang va nhin Spacebar
B. Chon toan bQbang va nhin Ctrl+C
c. Chon toan bQbang va nhin Delete
D. D~t con tr6 so~n thao vao 6 b~t ky trong bang va vao tab Table Tools\Layout -> Delete -

> Delete Table
Cau 124.
Trong MS Word, mu6n chen mQthirih imh da duQ'cluu tren 6 dla vao van ban t~i vi tri con tr6
so~n thao, ta bit d~u thlJc hi~n nhtr m~nao?

I

A. Insert --> WordArt
B. Insert --> Clip Art
C. Insert --> Shapes
D. Insert --> Picture

Cau 125.
Trong MS Word 2010, sau khi chQt1mQtbuc tranh trong van ban, each nao sau day cho phep
thay d6i kich thtro'c cua buc tranh d~?

A. Dua tro chuQt d~n bien cua DUC tranh va keo d~n kich thuac mong mU6n va tha chuQt.
B. Nhin Ctrl+X; nhin Ctrl+V :

I
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C. Format --> Crop --> Dua tro chuot dSn bien cua buc tranh va keo dSn kich thuoc mong
mu6n va tha chuot.

D. Format --> Compress Pictures
Call 126.
Trong MS Word 20] 0, muen xoa mQt d6i tuong d6 hoa, ta chon d6i nrong do va chon each
nao?

A. Format --> Align Text
B. Nhin Delete
C. Nh~n Ctrl +V
D. Format --> Text Direction

Call 127.
Trong MS Word 2010, d~ dua m(>th(>pvan ban moi van van ban dang soan thao, ta lam nhir
thS nao?

A. Insert --> Word Art
B. Insert --> Text Box --> Draw Text Box va ve vao vi tri mong muon
c. Insert --> Shapes --> chon hinh chir nhat va ve van vi tri mong mudn
D. Insert --> Object --> chon OpenDocument Text

Call 128.
Trong MS Word 2010, ta van tab References --> Insert Footnote d~ thuc hien cong viec nao?

A. Tao chu thich tai chan trang van ban
B. Tao tieu d~ cho chan trang van ban
c. Tao tieu d~ cho dftu trang va chan trang van ban
D. Tao chu thich tai cu6i bai van ban

Call 129.
Trong MS Word 2010, ta chon tab Insert --> Page Number d~ thirc hien:

A. Chen tieu d~ dftu trang cho tai li~u
B. Danh s6 trang cho tai li~u
C. Chen chan trang cho tid lieu
D. Them t6ng s6 trang van cu6i tai li~u

Call 130.
Trong MS Word, d~ can l~d~u hai ben cho toan b(>van ban ta chQn toan b(>van ban do va nh~n
t6 hQ'pphim gi?

A. Ctrl+E
B. Ctrl+L
C. Ctrl+J
D. Ctrl+R

Call 131.
Trong MS Word 2010, nhom I~nh Header & Footer trong tab Insert dung d~ thvc hi~n cong
vi~c lien quan dSn ph§.n nao cua van ban?

A. Phftn dftu va chan trang
B. Hang d§.u tien va hang cu6i cung cua bang bi~ll
C. Trang d§.u tien va trang cu6i cling cua van ban
D. Phftn dftu va cu6i do~n
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Cau 132.
Khi soan thao van ban hanh chinh thea quy dinh hien hanh, yeu du stt dung bang rna nao?

A. Vietware X
B. TCVN3 (ABC)
C. VNI WINDOWS
D. Unicode

M4. Sang tinh di~n tU'
Cau 133.
Trang MS Excel, vung (khoi 0) la:

A. Tap hop nhi§u 0 kS c~n nhau
B. Tap hop cac 0 kS c~n nhau cung n~m tren mot dong hoac mot cQt
C. Tap hop cac 0 duoc chon trong bang tinh
D. Tap hop cac 0 kS c~n nhau tao ndn hinh chu nh~t

Cau 134.
Trong bang tinh Excel, giao giua hang ya cQt la:

A. Truong
B. Dtr lieu
C. Cong thirc
D. 6

Cau 135.
Trong MS Excel, dia chi kh6i 0 (vungj nao sau day la dung cu phap:

A. BI-B15:HI-H15
B. Bl...H15
C. Bl:H15
D. Bl..H15

Cau 136.
Phat bieu nao sau day la dung khi noi v~kieu dfr lieu dung trong Excel?

A. Nhirng thi~t d~t lien quan d~n ki~u dir lieu thuoc tab Fill cua hop hOi thoai Format Cells
B. Khi nhap dfr lieu b~t ky cho mQt 0, m?c dinh dfr li~u luon thuOc ki~u General (D~ng

chung)
C. Dfr li~u trong mQt a phai thUQ~v~ 111Qtki~u dfr li~u xac dinh
D. Dfr li~u trong 1110t0 co th~ thuOc v~ nhi~u ki~u dfr li~u

Cau 137.
Trong MS Excel, n~u ta nh~p day s6 "1234" VilO 1110t0 va dinh d~ng ki~u dfr li~u la Text, dfr
li~u se duqc:

A. Canh phai, khang th~ Slr d\lng trong cong thuc tinh toan nhu 1110ts6 nguyen
B. Canh trai, co th~ Slr d1,lngtrartg cang thuc tinh toan nhu 1110ts6 nguyen
C. Canh trai, khang th~ sir d1,lngtrong cong thuc dnh toan nhu 1110ts6 nguyen
D. Canh phai, co th~ Slr d1,lngtrdng cang thuc tinh toan nhu 1110ts6 nguyen

Cau 138.
Trang MS Excel, d~ ch<;>n1110tvung: trong trang tinh, ta ch<;>na d~u tien ben trai, nh~n gifr phi111
nao sau day d~ ti~p t\lC ch<;>na cu6i tung ben phai cua vung?

A. Tab
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B. Alt
C. Ctrl
D. Shift

Call 139.
Trong MS Excel, khi dang nhap nQi dung VaG0, muon k~t thuc nhap va huy luon dfr li~u da
nhap, ta nhan phim:

A. Enter
B. Delete
C. Esc
D. Backspace

Cau 140.
Trong MS Excel, khi s~p x~p dfr lieu, d~ co th~ them tieu chi, trong hop thoai Sort ta chon:

A. My data has headers
B. Delete Level
C. Add Level
D. Copy Level

Cau 141.
Trong MS Excel, khi s~p xep dfr lieu, d~ dong tieu d~ cQt cua bang dfr lieu khong tham gia vao
s~p x~p nhu mot ban ghi thong thuong, trong hQp thoai Sort ta chon:

A. My data has headers
B. Delete Level
C. Add Level
D. Copy Level

Cau 142.
Trong MS Excel, d~ chon cac cQt k~ nhau, ta chi dn click chon cQt dAu tien va cQt cuoi cung,
trong qua trinh tren, dn nhan gifr phim nao sau day?

A. Shift
B. Alt
C. Ctrl
D. Ctr+Shift

Cau 143.
Chon cau dung di~n vao d~u ba cham trong phat bieu sau day: "Trong MS Excel, ...."

A. Chien rong cQt co th~ khac nhau va co th~ thay d6i diroc tren mot hoac nhi~u cQtduoc
chon

B. Ch·i~urong cQt se nr dong thay d6i n~u ta nh~p nQi dung dai han so vai dQrQng ban dAu
eua cQt

C. Chi~u fQng cac cQt luon b~ng nhau, va khong th~ thay d6i duQ'c
D. Chi~u fQng cac cQt luon b~ng nhau, n~u thay d6i chi~u rQng mQt cQt thi cac cQt khac se

thay d6i thea
Cau 144.
Trong MS Excel, d~ thay d6i chi~u cao mQt dong, ta thl!c hi~n thao tac

A. Home -> Cells -> Format -> Column Width ...
B. Home -> Cells -> Format -> Row Height...
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C. Home -> Cells -> Format -> Default Width ...
D. Home -> Cells -> Format -> AutoFit Row Height...

Call 145.
Trong MS Excel, d~ dong bang ca dong lfrn cot, ta chon <) ben phai cQt va phia duoi dong muon
c6 dinh, sau khi thirc hien day lenh View --> Window --> Freeze Panes ta tiep rue thirc hien
chon lenh:

A. Freeze Panes
B. Unfreeze Panes
C. Freeze first column
D. Freeze top row

Call 146.
Khi dang lam viec voi b~ng tinh MS E~cel, muon t~em,mQt trang tinh moi, ta thirc hien:

A. Chon trang tinh narn sau trang can them, nhan to hop phim Ctrl + Shift + F 11
B. Chon trang tinh n~m truce trang dn them, nh~n t6 hop phim Shift + Fll
C. Chon trang tinh n~m sau trang dn them, nh~n t6 hop phim Shift + F 11
D. Chon trang tinh nam truce trang dn them, nhfin t6 hop phim Ctrl + Shift + F11

Call 147.
Trong MS Excel, khi trong bang tinh co mdt trang tinh bi h,d~ dira trang tinh do xu~t hien tro
lai, ta thirc hien thao tac nao sau day?

A. Nh~n t6 hop phim Shift + F 11
B. Click phai len mdt trang tinh b§t ky trong bang tinh, chon Hide.
C. Click phai len mot trang tinh b4t ky trong bang tinh, chon Unhide va sau do chon ten

trang tinh dn xu~t hien, nh~n OK.
D. Nh~n t6 hqp phim Ctrl + F 11

Call 148.
Trong MS Excel, khi lam vi~c vai bang tinh, ta KHONG th~ thvc hi~n nhfrng thao tac nao sau
day vai mQt trang tinh:

A. Them mai mQt trang tinh
B. D6i ten d~ 2 trang tlnh tren mQt bang tlnh co ten trimg nhau
C. Xoa mQt trang tinh
D. Thay d6i vi tri cac trang tinh tten mQt bang tinh

Call 149.
Trong bang tinh MS Excel, co mQt trang t1nh dang m~c dinh vai ten Sheet 1, khi d6i sang
nhfrng cai ten sau, ten nao Excel KHONG ch~p nh?n:

A. 01
B. DanhSachSinh VienKhoaCongN gheThongTin
C. Danh sach sinh vien khoa CNTT
D. 2021-DanhSachSV-CNTT

Call 150.
Khi lam vi~c vai bang tinh MS Excel, thao tac nao sau day KHONG th~ thvc hi~n duqc?

A. Nhan ban mQt trang tinh vai ~enkhong d6i len bang tinh khac
B. Nhan ban mQt trang tlnh vai len khong d6i t?i cling mQt bang dnh
C. Nhan ban mQt trang tinh vai ten khac ti;licling mQt bang tinh
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D. Nhan ban m<)t trang tinh voi ten khac len bang tinh khac

Cau 151.
Trang bang tinh MS Excel, cong thirc nao sau day la hop I~?

A. =A3 + 12*A4
B. = A3 + 12 x A4
C. = A3 + 12:A4
D. A3+12*A4

Cau 152.
Trong bang tinh MS Excel, cong thirc "= 2 + 3 " 2 / 2" cho k~t qua la:

A. 6,5
B. 5
C. Baa 16i
D. 12,5

Cau 153.
Trong bang tinh MS Excel, khi ban go cong thirc "= A2/0", k~t qua hi:

A. Baa 16i #DIV/O!
B. Baa 16i #VALUE!
C. 0
D. Baa 16i #NUM!

Cau 154.
Trang bang tinh MS Excel, khi co 16i bao tai mQt 0 la ####, 0 do bi 16i nao sau day:

A. Dfr lieu khong dung ki~u s6
B. Khong co dfr lieu d~ tinh toan
C. Khong du d<)rong cua <3 d~ hi~n thi
D. Khong xac dinh duoc vi tri trong cong thuc

Cau 155.
Trong bang tinh MS Excel, <3 A1 co gia tri 0, 0 B 1 co gia tri 12. Tai <3 C I go cong thirc
"=Al:Bl" thi nhan duoc k~t qua:

A. 0
B. #DIV/O!
C. 012
D. #VALUE!

Cau 156.
Trong bang tinh MS Excel, dS tinh t6ng cua cac gia tri s6 trong danh sach d6i s6, ta sir dung
ham:

A. Average( d6i s6 1; d6i s6 2; ... )
B. Max(d6i s6 1; d6i s6 2; )
C. Min(d6i s6 1; d6i s6 2; )
D. Sum(d6i s6 1; d6i s6 2; )

Cau 157.
Trang bang tinh MS Excel, d~ tinh trung binh cQng cua cac gia tri s6 trang danh sach d6i s6, ta
su dt,mg ham:
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A. Sum(d6i s6 1; d6i s6 2; )
B. Count(d6i s6 1; d6i s6 2; )
c. Average( d6i s6 1; d6i s6 2; )
D. CountA(d6i s6 I; d6i s6 2; )

Cau 158.
T~'on9bang tinh MS Excel, d~ tim gia tri.lon nh~t trong t~t ca cac gia tri s6 co trong danh sach
doi so, ta SIT dung ham: :

A. Averagetdoi s6 1; d6i s6 2; ... )
B. Min(d6i s6 1; d6i s6 2; )
C. Max(d6i s6 1; d6i s6 2; )
D. Mid(D6i s6 1, D6i s6 2)

Cau 159.
Trang bang tinh MS Excel, d~ tim gia tr] nho nhat cua mQt t~p gia tri s6, ta su dung ham:

A. Max(d6i s6 1; d6i s6 2; )
B. Sumlf(d6i s6 1; d6i s6 2; )
C. Min(d6i s6 1; d6i s6 2; ... )
D. Roundtddi s6 1; d6i s6 2; ... )

Cau 160.
Trang bang tinh MS Excel, d~ d~m s6 ~uQ'ngcac gia tri s6 co trong mQt t~p hop dfr lieu, ta sir
dung ham:

A. CountA( d6i s6 1; d6i s6 2; )
B. Count( d6i s6 1; d6i s6 2; )
C. CountIf( d6i s6 1; d6i s6 2; )
D. Round(d6i s6 1; d6i s6 2; )

Cau 161.
Trong bang tinh MS Excel, d~ d~m cat 0 khong ding, ta su d\mg ham:

A. CountA
B. Count
C. Sumif
D. Round

Cau 162.
Trang MS Excel, d~ lam trcm mQt s6 o~n n s6 tMp phan, ham nao sau day Iiidung?

A. Round(n, D6i s6)
B. int(D6i s6, n)
C. int(n, D6i s6)
D. Round(D6i s6, n)

Cau 163.
Trong bang tinh MS Excel, trong caa cong thuc sau, cong thuc nao cho k~t qua la FALSE?

A. = OR(2)3;2>=I) .
B. =OR(2=1;2>1)
C. =AND(2)3;2>1)
D. = AND(3)2;2> 1)
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Call 164.
Trong bang tinh MS Excel, gia SLY 0 Al dang co gia tri hi 7. Trang cac cong thirc sau, cong thirc
nao cho k~t qua la TRUE?

A. = Al<>Al
B. = A 1<a 1< label=""> </a 1<>
C. =AI=Al
D. = Al>AI

Call 165.
Trong MS Excel, cong thirc "=HOUR(,121112/2016 5:56:90")", cho k~t qua la:

A. 21
B. 5
C. 56
D. 12

Call 166.
Gia sir ngay cua h~ thong may tinh la 26/10/2016; Khi do, trong bang tinh MS Excel, cong thirc
"=TODAYO-l" cho k~t qua Ii:

A. 25/10/2016
B. #NAME?
C. 26/09/2016
D. #VALUEl

Call 167.
Trang bang tinh MS Excel, d~ dinh dang ki~u cho mot s6 th~p phan, trong muc lua chon
Category cua h9P thoai Format Cells, ta chon:

A. Number
B. Date
C. Percentage
D. General

Call 168.
Trong bang tinh MS Excel, d~ dinh dang s6 co ki~u ty I~ phan tram, trong muc Iva chon
Category cua h9P thoai Format Cells, ta chon:

A. Accounting
B. Special
C. Percentage
D. Text
E. Scientific
F. Date

Call 169.
Trang bang tinh MS Excel, d~ dinh dang s6 co kieu ti~n t~, trong muc hra chon Category cua
h9P hQi thoai Format Cells, ta chon:

A. General
B. Currency
C. Percentage
D. Text
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Call 170.
Trang bang tinh MS Excel, d~ nhap nhi6u 0 trong mot vung duoc chon thanh mot 0, ta su dung
chirc nang:

A. Split Cell
B. Merge Cells
C. Unmerge Cells
D. Wrap Text

Call 171.
Tren MS Excel, d~ t<;10bieu d6, ta thuc bien thao tac:

A. Data -> Charts '
B. Home -> Charts
C. File -> Charts
D. Insert -> Charts

Call 172.
Trong MS Excel, d6i voi viec sao chep mQt bi~u d6 tir bang tinh A sang bang tinh B, phat bieu
nao sau day lit dung? .

A. T~ay d6i 10<;1ibien d6 a bang tin~ A thi bang tinh B se tu dong thay d6i theo
B. Bat bUQCphai sao chep kern bang dfr lieu tir bang tinh A sang bang tinh B
C. Thay d6i dli' li~u cua bieu d6 tre~ bang tinh A d~n d~n S\I thay d6i cua bieu d6 tren bang

tinh B
D. Thay d6i dinh dang cua bieu d6 :tren bang tinh A d~n d~n Sl,Ithay d6i cua bieu d6 tren

bang tinh B
Call 173.
Trong MS Excel, d~ xem tnroc b6 tri trang in, ta thuc hien:

A. Page Layout --> Page Setup --> Margins --> Custom Margins ...
B. View --> Page Break Preview
C. Page Layout --> Page Setup --> Orientation
D. Page Layout --> Page Setup --> size

Call 174.
Trong MS Excel, khi sao chep cong thirc tir mot ° d~n mQt s6 0 khac, nhung gia tri cac 0 d6
v~n khong duqc c~p nh~t tuang ung vai cong thuc. DS kh~c phl,lc 16i nay, ta nhfrn phim:

A. Nhfrn F12
B. Nhfrn F9
C. Nhftn FII
D. Nhftn F2

Call 175.
Trong bang tinh MS Excel, dS I~p l<;1ivi~c in tieu d~ Clla bang dfr li~u tren nhi~u trang in, sau
khi thl,Ic hi~n thao tac Page Layout -7> Page Setup --> Sheet, ta chQn:

A. Rows to repeat at top --> Chi:duqc chQn mQt dong mU6n l~p l<;1ia d~u m6i trang in
B. Rows to repeat at top -> ChQn mQt ho~c nhi~u dong mU6n l~p l<;1ia d~u m6i trang in
C. Columns to repeat at left -> ChQn mQt ho~c nhi~u dong mU6n l~p l<;1ia d~u m6i trang in
D. Danh dftu vito Rowand colUlpn headings

Call 176.
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Trong MS Excel 2016, co th~ hru bang tinh duoi dang cac kieu t~p nao?
A, Chi co thS hru duoi dang t~p .pdf
B. Co th~ luu diroc voi t~t ca cac dang t~p co trong muc Save as type cua hQp thoai Save as
C. Chi hru diroc voi dang t~p .xls hoac .xlsx
D. Chi hru duoc voi dang t~p .xls

MS. Trinh chleu
Cau 177.
Cac nhan t6 anh huang d~n chat IUQ'ngcua mot bai thuyet trinh ngoai hai nhan t6 NQi dung va
Con nguoi la:

A, Thi~t bi, khong gian thuyet trinh
B, Tam ly, giong noi
C. Su chuan bi, may tinh
D. Su chuan bi, tam ly

Cau 178.
Cac buoc chinh trong tao va thuc hien mot bai thuyet trinh la:

A, Xac dinh muc tieu thuyet trinh; Thi~t k~, bien t~p nQi dung cac trang ella bai thuyet
trinh; Luu va xu~t ban nQi dung bai thuy~t trinh; Thl,lc hi~n vi~e thuy~t trinh b~ng mQt
cang C\l trinh chi~u.

B. Thi~t k~,bien t~p nQi dung cac trang Clla bai thuy~t trinh; Luu va xu~t ban nQi dung bai
thuy~t trinh; Thl,lc hi~n vi~e thuy~t trinh b~ng mQt cang C\l trinh chi~u,

C. Xae dinh m\lC tieu thuy~t trinh; Thi~t k~,bien t~p nQi dung cae trang Clla hai thuy~t
trinh; Luu va xufrt bim nQi dung hai thuy~t trinh;

D, Thi~t k~,bien t?P nQi dung cac trang ella bai thuy~t trinh; Luu va xufrt ban nQi dung bai
thuy~t trinh;

Ciu 179.
Ngoai vi~e t~o va trinh chi~u cac slide chua nQi dung van ban, MS PowerPoint con co chue
nang chinh la t~o:

A. Hinh ve, am thanh va do~n phim,
B. Hinh ve, am thanh, phim, vo-i cae hi~u ung sinh dQng.
C. Hinh anh, am thanh,
D, Hinh ve, am thanh, phim, vai cae hi~u trng sinh dQng; nhung cae ph~n mSm kh.:lc vao

MS PowerPoint.
Cau 180.
Trong MS PowerPoint 20 16, d~ rna mQt t~p trinh di~n dii co s~n tren dIa, th\IC hi~n thao tac:

A. File --> Export
B, File --> Open --> chQn t~p dn rna
C. File --> New
D, File --> Info

Cau 181.
Trong MS PowerPoint 2016, dS t~o mQt trinh di~n tr6ng, th\Ic hi~n thao tac:

A, File --> New --> Blank Presentation
B. File --> Save
C. File --> Save As
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D. File --> Open
Call 182.
Trong MS PowerPoint 20 16, d~ hru hili thuyet trinh co m~t khau, sau khi thuc hien thao tac
File --> Info --> Protect Presentation, ta chon:

A. Mark as Final
B. Encrypt with Password
C. Restric Access
D. Add a digital Signature

Call 183.
Trong MS PowerPoint 20 16, ch~ do hi~n thi Reading View la:

A. Ch~ dO soan thao
B. Xem tftt ca cac Slide
C. Ch~ dOhien thi d~ doc
D. Ch~ do trinh chieu

Call 184.
Trong MS PowerPoint 20 16, d~ xem t6~g quan tftt ca cac Slide, a goc duoi phai man hinh chon
nut lenh: '

A. Slide Show
B. Reading view
C. Slide sorter
D. Normal

Call 185.
Trong MS PowerPoint 20 16, d~ hru hili thuyet trinh voi ki~u t~p khac .pptx, thuc hien thao tac:

A. File --> Save as --> go ten t~p moi
B. File --> Info --> Protect Document --> Encrypt with Password
C. File --> Save as type --> chon ki~u t~p muon luu
D. File --> Info --> Manage Presentation

Call 186.
Trong MS PowerPoint 2016, thao tac View --> Arrange All dung d~:

A. Chuyen nr bai thuyet trinh nay sang bai thuyet trinh khac
B. Mo dang thai nhi~u bai thuyettrinh dang mo
C. Mo bai thuyet trinh
D. Dong bai thuye; trinh

Call 187.
Trong MS PowerPoint 2016, trang thuyet trinh co vai tro la:

A. Mot each thirc giao ti~p phu hop voi nhieu tinh huong phat bi~u
B. Mot SlJ th~ hi~n va di~n giai l~Oidung cua mot chu d~ cho khan gia ho~c nguai hQc
C. Chua noi dung van ban, hinh N'e, am thanh, do~n phim va th~m chi vai cac hi~u ung d~c

bi~t sinh dong ...
D. Dan vj noi dung nh6 nhftt du thimh mQt hili thuy~t trinh

Call 188.
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Trong MS PowerPoint 20 16, phan dung dS mieu ta d~u dS cho mQt trang, dai dien cho nQi dung
se thS hien trong trang thuyet trinh goi Iii:

A. Tieu dS
B. Chu dS
C. B6 C\lC

D. Chu thieh
Cau 189.
Trong MS PowerPoint 2016, dS trang thuyet trinh diroc trinh bay mQt each chuyen nghiep, cac
d6i tuong trong tung trang s~p x~p khoa hoc, ta dn su dung:

A. Hi~u irng dQng
B. B6 C\lC

C. Lien k~t trang
D. Tieu dS

Cau 190.
Trong MS PowerPoint 20 16, d~ thiet k~ bai thuyet trinh thea chu dS s~n co, thuc hien thao tac:

A. File --> Save As
B. File --> Open --> Chon m~u co s~n
C. File --> New --> Chon m~u co s~n
D. File --> Export

Cau 191.
Khi thi~t k~ trang thuyet trinh chu r6i ap dung cho cac trang thuyet trinh khac trong bai thuyet
trinh, ta sir dung:

A. Slide layouts
B. Tieu dS slide
C. Slide Master
D. Slide

Cau 192.
Trang MS PowerPoint 2016, dS thi~t k~ trang thuyet trinh chu cho bai thuyet trinh, thuc hien
thao tac:

A. View --> Master Views --> Notes Master
B. Insert --> Slides --> New Slide
C. View --> Master Views --> Slide Master
D. View --> Master Views --> Handout Master

Cau 193.
Trong MS PowerPoint 2016, dS them mQt slide van bili thuy~t trinh, th1,1chi~n thao tac:

A. Home --> Clipboard --> Copy
B. Home --> Clipboard --> Cut
C. Home --> Slides --> New Slide
D. Home --> Slides --> Layout

Cau 194.
Trong MS PowerPoint 2016, sau khi th1,1chi~n thao tac Copy mQt trang thuySt trinh van
Clipboard, thao tac Home --> Clipboard --> Paste nh~m th1,1chi~n:

A. Dan trang thuy~t trinh
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B. C~t trang thuyet trinh
C. Sao chep trang thuyet trinh
D. Di chuyen trang thuyet trinh

Cau 195.
D&xiiy dung mot trang thuyet trinh t6t, chung ta k~t hop cac ky nang sau:

A. Chon mau n~n va Font chir, cO'ch~; Sir dung hinh thirc li~t ke hieu qua.
B. Chon mau nen va Font chir, cO'ch\}; LUQ'ngnQidung truyen tai tren mot Slide; Sir dung

hinh tlnrc li~t ke hieu qua; Bi~t caqh d?t tieu d~ trang thuyet trinh.
C. Sir dung hin~ thirc li~t ke hieu qu~; Bi~t each d?t tieu d~ t~ang thuyet trinh.
D. Chon mau nen va Font chir, cO'chft; LUQ'ngnoi dung truyen tai tren mot Slide.

I

Cau 196.
Trong MS PowerPoint 2016, d&xoa van ban trong bai thuyet trinh, ta chon phan van ban dn
xoa va thuc hien thao tac: I

A. Home --> Clipboard --> Copy
B. Nhftn Insert tren ban phim
C. Nhftn Delete tren ban phim
D. Home --> Clipboard --> Paste

Cau 197.
Trang MS PowerPoint 20 16, d~ thay d61iki&uchfr cho van bim, chung ta chQn phfm van ban
dn thay d6i va thl,Ichi~n thao hie: :

A. Home --> Font --> Font color
B. Home --> Font --> Font Style
C. Home --> Font --> Size
D. Home --> Font --> Underline

Cau 198.
Trang MS PowerPoint 2016, d&din gifra van ban trong khung, chung ta chQn do~mvan ban dn
can va thl,IChi~n thao tac: '

A. Home --> Paragraph --> Cente);
B. Home --> Paragraph --> Justify
C. Home --> Paragraph --> Align teft
D. Home --> Paragraph --> Align:Right

Cau 199.
Trang MS PowerPoint 2016, d&trinh ;bay nQi dung duai d~ng danh sach li~t ke dung ky hi~u
danh dftu d~u dong, thl,Ic hi~n thao taq:

A. Home --> Paragraph --> Bullet
B. Home --> Paragraph --> Line Spacing
C. Home --> Paragraph --> Numbering
D. Home --> Paragraph --> Center

Cau 200.
Trang MS PowerPoint 2016, d&trinb bay nQi dung duai d~ng danh sach duQ'cdanh s6 thu tv tv
dQng, thvc hi~n thao tac: :

A. Home --> Paragraph --> Bull~t
B. Home --> Paragraph --> Nu~bering
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C. Home --> Paragraph --> Align Text
D. Home --> Paragraph --> Line Spacing

Cau 201. " "
Trong MS PowerPoint 2016, de ve bieu do din co:

A. T~p dfr li~u duo: dang van ban
B. T~p dfr li~u duoi dang van ban hru trong Excel
C. T~p dfr li~u duci dang van ban luu trong Word
D. Tap dfr lieu duoc hru duoi dang bang trong Excel

Cau 202. , " '
Trong MS PowerPoint 20 16, d~ thay d6i kieu bieu d6, chung ta chon bieu do can thay d6i va
thuc hien thao tac:

A. Design --> Data --> Refresh Data
B. Design --> Type --> Change Chart Type
C. Design --> Chart Styles --> Change Colors
D. Design --> Data --> Edit Data

Cau 203.
Trong MS PowerPoint 20 16, d~ t:;10sa d6 t6 chirc nhi~u rmrc, thuc hien thao tac:

A. Insert --> Illustrations --> SmartArt
B. Insert --> Tables --> Table
C. Insert --> Illustrations --> Shapes
D. Insert --> Illustrations --> Chart

Cau 204.
Trong MS PowerPoint 20 16, d~ thay d6i du true phan dp cua sa d6 t6 chirc, chung ta chon sa
d6 cAnthay d6i va thuc hien thao tac:

A. Design --> Layouts
B. Design --> Change Colors
C. Design --> SmartArt Stypes
D. Design --> Reset --> Convert

Cflu 205.
Trong MS PowerPoint 20 16, d~ chen hinh ve vao trang thuyet trinh, thuc hien thao tac:

A. Insert --> Illustrations --> Chart
B. Insert --> Illustrations --> Shapes
C. Insert --> Images --> Screenshot
D. Insert --> Illustrations --> SmartArt

Cau 206.
Trong MS PowerPoint 20 16, d~ chen bieu d6 van trang thuyet trinh, thuc hien thao tac:

A. Insert --> Images --> Screenshot
B. Insert --> Illustrations --> SmartArt
C. Insert --> Illustrations --> Shapes
D. Insert --> Illustrations --> Chart

Cau 207.
Trong MS PowerPoint 20 16, d~ chen sa d6 quy trinh vao trang thuyet trinh, thuc hien thao tac:
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A. Insert --> Illustrations --> SmartArt --> Matrix
B. Insert --> Illustrations --> SmartArt --> List
C. Insert --> Illustrations --> SmartArt --> Cycle
D. Insert --> Illustrations --> SmartArt --> Process

Cau 208.
Trong ~S PowerPoint 20 16, d~ xoa d6i nrong ben trong bai thuyet trinh chung ta chon d6i
tuong can xoa va thuc hien thao tac: '.

A. Ho~e --> Clipboard --> Copy
B. Nhan Insert
C. Home --> Clipboard --> Paste
D. Nhfrn Delete

Can 209.
Trong MS PowerPoint 20 16, d~ ve cac hlnh mfii ten dang kh6i trong trang thuyet trinh, thuc
hi~n thao tac Insert --> Illustrations --> Shapes va chon:

A. Chon cac hinh trong nh6m Callouts
B. Chon cac hinh trong nhom Block ~ITOWS

C. Chon cac hinh trong nhom Basic $hapes
D. Chon cac hinh trong nhorn Lines!

Can 210.
Trang MS PowerPoint 20 16, d~ nhap va~ ban VaGhinh ve, chung ta chon hinh dn nhap van
ban VaGva thuc hien thao tac: '

A. Format --> Shape Styles --> Shape Fill
B. Format --> Shape Styles --> Shape Effects
C. Right Click va chon Edit Text :
D. Format --> Shape Styles --> Shape Outline

Can 211. ,
Trong MS PowerPoint 20 16, d~ thay d~i mau n~n cho hinh ve, thirc hien thao tac:

A. Format --> Insert Shapes --> Edit Shape
B. Format --> Shapes Styles --> Shape Effects
C. Format --> Shapes Styles --> Shape Outline
D. Format --> Shapes Styles --> S~ape Fill

Can 212.
Trong MS PowerPoint 2016, thao tac chQn cac d6i tuq~g ve trong trang thuy~t trinh, sau d6
chon Format --> Arrange --> Group -~>Group dung de:

.A. Ghep nh6m eae d6i tuqng
B. S~p x~p cac d6i tuqng
C. To mau cac d6i tuqng
D. Huy ghep nh6m cae d6i tuqng

Can 213.
Trong MS PowerPoint 2016, thao taq chQnd6i tuqng va VaGFormat --> Arrange --> Bring
Forward --> Bring to Front dung d~:,'

A. Dua d6i tuqng ve len tren cung
B. Dua d6i tuqng ve ~n xu6ng pbia sau mQtd6i tuqng ve khac
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C. DU'ad6i tuong vc hien len phfa truce met d6i nrong ve khac
D. Dira d6i tirong ve xuong duoi cling

Cau 214.
Trang MS PowerPoint 2016, thao tac chon d6i nrong va vao Format --> Arrange --> Send
Backward --> Send Backward dung d~:

A. Dua d6i nrong ve hien len phia truce mot d6i nrong ve khac
B. Dua d6i tuong ve ~n xuong phia sau mot d6i tuong ve khac
C. Dira d6i tuong ve xuong duoi cling
D. Dua d6i nrong ve len tren cling

Cau 215.
Trong MS PowerPoint 20 16, d~ chuyen canh til mQt trang thuy~t trinh nay d~n trang thuyet
trinh khac khi trinh diSn bai thuyet trinh, ta thuc hien:

A. Tao hieu irng chuyen trang
B. Tao hieu img dong tung d6i tuong
C. Tao hieu img dong cho mQt d6i tuong
D. Tao hieu irng dong cho tftt ca cac d6i tuong

Cau 216.
Trong MS PowerPoint 20 16, d~ thay d6i t6c dQchuy~n trang cho Slide, thvc hi~n thao tac:

A. Transitions --> Transition to This Slide
B. Animations --> Timing --> Duration
C. Transitions --> Timing --> Duration
D. Animations --> Advanced Animation

Cau 217.
Trong MS PowerPoint 20 16, d~ them phin ghi chu cho trang thuy~t trinh, thvc hi~n thao tac:

A. View --> Master Views --> Handout Master
B. View --> Master Views --> Slide Master
C. View --> Show --> Notes
D. View --> Show --> Gridlines

Cau 218.
Trong MS PowerPoint 20 16, d~ thay d6i kich cO' trang thuy~t trinh, thlJc hi~n thao tac Design
-7 Customize --> Slide Size va:

A. ChQn m\lc Notes, Handouts & Outline
B. ChQn m\lCNumber slides from:
C. ChQn m\lCSlides sized for:
D. ChQn m\lc Slides

Cau 219.
Trong MS PowerPoint 20 16, d~ trinh chi~u tu Slide hi~n thai, thlJc hi~n thao tac Slide Show -7
Start Slide Show va chQn:

A. From Beginning
B. From Current Slide
C. Present Online
D. Custon Slide Show
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Cau 220.
Trong MS PowerPoint 2016, muon cham dirt ch~ do trinh chieu thuc hien thao tac:, .,. .

A. Nhan phim Esc
B. Nhfrn phim Break
C. Nhfrn phim Enter
D. Nhfrn phim Space Bar

M6. Internet
Cau 221.
Cac irng dung chinh cua Internet la:

A. Trao d6i thong tin va dfr li~u, chia se tai nguyen, tra ciru va tim kiem thong tin, lam viec
va kinh doanh true tuyen

B. Tra? d6i thong tin va dfr lieu, tra ~u·uva tim ki~m thong tin, lam viec va kinh doanh true
tuyen

C. Thu dien nr, mang xa hoi, chat, epng cu tim kiern, cac dich vu true tuyen ,
D. Tlnr dien nr, chat, cong cu tim kidm, cac dich VI) true tuyen, hru tnr dfr lieu true tuyen

Cau 222.
Thuat ngfr World Wide Web nghia la gi]

A. La th~ gioi ao diroc tao ra dna v~o Internet thong qua cac trang web
B. La M theng thong tin toan du rna ITIQinguoi co th~ truy c~p tren Internet
C. La M thong cae dich V\l toan d4 duQ'Ccung dp thong qua cac trang web tren Internet
D. La M th6ng cae dieh V\l tren Internet dUQ'elTIa rong tll'web

Cau 223.
Trang thong tin di~n tu (Website) la:

A. Mot t6 hQ'pbaa g6m: van ban, hrinhanh, video, flash, sieu lien k~t... d~ trinh bay mot
ho~c mot vai thong tin nao do :

B. Mot t~p hQ'pcae trang web can trinh bay cae tin tue e~p nh~t h~ng ngay
C. Mot t6 hQ'pbaa g6m: van ban, Hinh anh, video, flash, sieu lien k~t... d~ trinh bay mot

ho~e mot tin ttrc thai SlJ nao do.
D. Mot t~p hQ'pcae trang web con dmg ten mi€n

Cau 224.
f)~ xem noi dung cae trang web ta dung eong C\l nao sau day?

A. Google
B. Microsoft Word
C. Web Browser
D. Internet Explorer

Cau 225.
http://www.google.eom la dia chi cua trang web n6i ti~ng vai dieh V\l nao?

A. Tim ki~m thong tin tren Internet
B. Gui thl! di~n tu tren Internet
C. DQc baa
D. Dieh van ban

Cau 226.
Vai tro eua ma hoa dfr li~u la gi?
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A. Ngan ngira viec l~y cap thong tinA .
B. Dam bao bi mat, toan ven cua ,thon~ tin ~ A
C. Dam bao thong tin duoc an ~oan~11ltr~yen tren mang
D. Tang t6c do thuc hien cac giao dich tren mang

Cau 227. ,. d b' Atkhi:
D~u hi~u dan gian nh~t d~ nhan bie,t m?t web~lte UQ'C ao rna .

A. Website duoc I~p boi mot ,to chirc uy tin
B. Dia chi Website b~t dftu bang https:/! ,
C. N~i dung Website khong mang tinh gay soc
D Dia chi Website chi ro ten mien. .

Cau 228. , . h" h hi A thao tac sau:
Khi S11 dung phftn mern duye: W.eb, de t~y c~p Va? mQ,tWebSite ta p ai t \IC ien .

A. Nhap ten mien cua Website do vao thanh dia chi. ,
B. Nhap ten t6 chirc quan Iy website do vao thanh dia C~l
C. NMp vi tri d~t may chu Website do vao thanh dia chi
D. Nhap URL cua Website do vao thanh dia chi

Cau 229.
"Cookie" la mQt thu~t ngfr dung d~ chi: , ,. ,

A. Mot dOl;\nrna g~n vao trang web de thu th~p tho,ng tin cua nguOl dung
B. Mot do an van ban luu ten dang nh~p va m~t khau cua nguai su d\lng
C. M~t ph~n mSm giam di~p dung d~ l~y c~p thong tin nguai dung tren m~ng ,. ,
D. MQt dOl;\nvan ban luu thong tin trl;\ng thai phien lam vi~c tren may dnh nguOi su d\lng

Cau 230.
Bi~u m~u tren trang web co cong d\lng chinh:

A. Hi~n thi thong tin mQt each th6ng nh~t
B. Hi~n thi trang web mQt each r6 rang, chinh xac
c. Thu th~p thong tin cua nguai dimg
D. NMp ho~c hi~n thi thong tin mQt each thu~n ti~n

Cau 231.
M~H3ntim ki~m nhanh cac tai li~u co chua CI,lTIltu "tai li~u tin h9C" thi trong cac cong Cl,ltim
kiem, ta dua vao van ban thea phuong an nao duai day?

A. tai li~u tin h9C
B. "tai Ji~u tin h9C"
C. "tai Ji~u" + "tin h9C"
D. "tai li~u" "tin h9C"

Cau 232.
N~u ta 511 dl,lng cong Cl,ltim kiSm GoogJe vai tu khoa tim ki~m la "tai lieu" - "tin hoc" thl
nhfrng trang web co chua nQi dung nao sau day duQ'c uu tien hi~n thi? . .

A. Nhfrng trang web co nQi dung khong ch(ra cl,lm tu "tin h9C" c'ung khong chua cl,lm tu
"tai Ji~u"

B. Nhfrng trang web co nQi dung chua c\lm til "tai lieu" va "tin hoc"
C. Nhung trang web co nQi dung chua cl,lm tu "t~i li~u" nhung khong chua cum tu "tin

h9c" .
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D. Nhii'ng trang web co n6i dung chtra f\lm ttl' "ta: lieu" hoac "tl' h "
Cau 233. . . n QC

Dali co th~ Ia mQt dia chi thir di~n tu dung?
A. hang67@gmail.eom
B. hang27@gmail
C. hang67.edu.vn
D. hang67@com.vn

Cau 234.
ThO' dien tu hi:

A. Dich vu chuyen thir cua BUll dien.
B. D~eh V\I trao ~6i thong tin qua mang
C. D~eh vu ehuy~n file gifra cac may tinh bang each su dung dia chi may tinh d~ giri,
D. Dich vu chuyen thu duoi dang so tren mang may tinh.

Cau 235.
Phishing la gi?

A. mQt duong d~n cua website lira dao,
B. viec xay dung nhfr~g M thong lira dao nham danh dp cac thong tin nhay cam, nhu ten

dang nhap, m~t khau hay thong tin vS cac loai the tin dung cua ngiroi dung.
C. mQt trang thong tin dien nr, eBay, Paypal.
D. Gia mao hay gian l~n qua email

Cau 236.
Khi su dung thu di~n ur Gmail, d~ giri toi nhieu nguci cung nhan mQt btrc thu ta thvc hi~n:

A. Chi ra dia chi nguai nh~n email trong ca truang nguai nh~n (to) va D6ng gui khong
hiSn thi (Blind copy, Bcc)

B. D6ng gui (Copy, Cc) va D6ng gui khong hi~n thi (Blind copy, Bcc) ,
C. Chi ra dia chi ngO'ai nh~n email trong ccl truang nguai nh~n (to) va Dong gui (Copy,

Cc)
D. Gui d~n mot dia chi nhom email ho~c nhiSu dia chi email trong truang nguai nh~n (to)

• • I
I

Cau 237. : '. ,
Khi su d\lng thu di~n tu Gmail, d~ gui tpi nhi~ll nguai nhung khong muon nhfrng ngu()'l cung
nMn email bi~t email nay co gui them 19uai khic.

A. Chu de (Subject). :
B. Nguai nh~n (To). I

C. D6ng gui (Copy, Cc). :
D. D6ng gui khong hi@nthi (Blind!copy, Bec).

Cau 238. I ,

Trang Gmail chuc nang Forward dung de lam gi?
A. Chuy@nti~p thu cho nguai ~h~.
B. Tra lai thO'cho nguai gui den. :
c. So~n thu maio "
D. Tnllai thu cho t~t ccl nhfrng n$uai co lien quan.

Cau 239.
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VoIP la dich vu gl?
A. Dam thoai thong qua giao thirc Internet
B. Truyen t~p tin duoi dang am thanh
C. Sir dung internet d~ truyen am thanh
D. GQidi~n thoai gifra hai may tinh

Cau 240.
Khach hang co th~ truy vAnthong tin tai khoan va thuc hi~n cac giao dich chuyen khoan, thanh
toan tren Ngan hang dien tu thong qua

A. Buu dien
B. Internet
C. Ngan hang
D. ATM
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Thi sinh lam bai tren Iii tra liii triu: nghi¢m. Khoanh Iron phuang an aung, vi du ®.
Niu muon chon phuong an khdc, gach cheo phuang an ail chon va khoanh laiphuang
an khac, vi du ail chon B va muon chon lai C: @g.

DE THI voxc 1
Mfm: Ti~ng Anh

Thai gian lam bai: 30 phut (khong kJ thOi gian giao d~)
Mfl d~ thi: 00

PART 1
QUESTIONS 1-5
Where can you see these notices?

ANSWER
AB©D l

o. [ Return books here )
A. in a school
B. m a room

C. in a library
D. in a classroom

1. PLEASE KEEP OFF THE
GRASS

A. at a restaurant C. at a corner

B. at a stadium D. at a park

2.
SLOWDOWN!
CHILDREN
CROSSING

A. on a road
B.

C. on a train
on a bus D. on the underground

3.

C. at a theare
D. at a circus

at a cinema
B. at a supermarket
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4.

5.

A. at a market
B. at home

C. on a street
D. at a station

A. at a cinema
B. at a theatre

C. at a museum
D. at a building

PART 2
QUESTIONS 6-10 I

I

Read the descriptions (6-10) of some holi ay words.
What is the correct word (A-D) of each
EXAMPLE

10.
O.

A.
B.

6.
A.
B.

7.
A.
B.

8.
A.
B.

9.
A.
B.

10.
A.
B.

ANSWER
® BCD

This is where you lie in the sun and go swimming.
beach C. postcard
suitcase D. sandwich

You can pack all your holiday clothes in this.
beach C. postcard
suitcase D. sandwich

Without this you cannot go to some countries.
beach C. postcard
tent D. passport

I

This is what you use to dry yturself after you go swimming.
beach C. postcard
tower I D. fish

I
I

You need to put a stamp on this to send it to a friend.
beach I C. postcard
suitcase I D. sandwich

If you go on a camping holi~ay, you may sleep in this.
tent I C. postcard
tower I D. beach

I
i
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PART 3
UESTIONS 11-15

Q (11-15) about playing a sport.R d the sentences
ea C or D) for each space.Choose the best word (A, B,

ANSWER
EXAMPLE A B © D
o.

Gloria playing sport very mucch.
likesB. wants .

D. hopeso.
A. decides

11.
. most interesting sport she plays.Gloria thinks football IS .•...•.......... D. an

B the C. oneA. a .

12. When Gloria plays, she .

about football.

A. remembers

. 1 d J.ust thinksabout everythmg e se an .

B. misses C. loses D. forgets

13.
herAfter school, Gloria puts on her football boots and plays .

friends.

A. without B. and C. with D. besides

14. some money fromWhen Gloria is older, she hopes that she can .

playing football.
A. get B. bring D. earnC. take

15. . f b 11fi h in the World Cup.One day Glona wants to play oot a or er .

A. country B. nationality C. group D. team

PART 4
QUESTIONS 16-22

Read the article about Sean Murphy then answer the questions.

Sean Murphy
Sean Murphy reads the late news on British television at 11 o'clock each evening.
This is a good time for a news programme because we can report the early news from

America and the late news from Europe. I stilI arrive home before midnight because the
journey from the Television Centre to my home in north London only takes six minutes. My
family are all sleep when I get in, but I usually make a drink of hot milk and read a book for
about an hour.
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"I always Bet up to have b kt '. .
6 rea ast wlth my tlJree chikiren before they catch the school
US. Then Itake the newspaper and go back to bed for a short time. Later on, I go for a swim

- news reader spend too much time sitting down. I sometimes go running. I've done the
London Marathon twice. That's the race 40 kilometers. I finished each time, but I wasn'tamong the first!"

"I start work after lunch at two o'clock, when I go to my office. The rest of the day is
spent planning the programme, but Ialways try to go home for an hour to see my children
before they go to bed.

IEXAMPLE

~.

ANSWER
ABC@

0 Sean Murphy is a ............ '"
A director C journalist
B Me D news reader

16 The late news begins at 11 o'clock every .
A mornmg C evening
B afternoon D day

17 Sean Murphy lives in .
A London
B America

C Europe
D Britain

18 He often arrives home .
A in the morning
B in the afternoon

C at noon
D in the evening

19
!

He reads for about/an hour.
I CA a newspaper .

DB a magazine

a book
a magazine

20 He has children.................

A three C one

B two

done the London Marathon.He has C just

D no

21
A never

B ever I

his work in the office in the afternoon.
22 He C goes

D not

A begins
B finishes

D continues
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PARTS
QUESTIONS 23-30

Read the email.
Choose the best word (A, B, C or D) for each space (23-30).

Dear Sir or Madam,
I ..... 0 .... like a room at my hotel for three nights from September 13th ••.•• 23 ..... 17th•

I'd like a single room .... 24 ..... a shower. I also need ..... 25..... telephone in my room.

Please can I have a quiet room on 26 ground floor?
I am going to drive to the hotel. Is 27 a hotel car park?
I will arrive ..... 28..... 10.30 p.m. What 29 does the restaurant close in the
evening? If possible, I would like a meal 30 I arrive.
Thank you for your help.
Your faithfully,

Mark Jones

I !.)(AMPLE
ANSWER

® B C D

O. A. would B. want C. will D. shall

23. A. between B. to C. and D. or

24. A. and B. have C. has D. with

25. A. the B.a C. this D. that

26. A. the B. this C. that D.a

27. A. this B. it C. there D. that

28. A. on B. in C. of D. at

29. A. o'clock B. time C. hour D. watch

30. A. because B. as C. when D. for

Ghi chu: ' . THE END -----
: T~I sl~h k~o~gdl!Q'C phep Slr dung Uti lieu;

H
" ,~an b9 COl thi khong duoc giai thich gi the'

9 va ten thl sinh: m.. :. ,.............................. , So bao danh: ...............................
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